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ABSTRAK 
 
Kurnia, Yusthesia Esta. 2020. Implementasi Algoritma Bee Colony Dengan Metode Fuzzy 

Mamdani Untuk Pengaturan Lampu Lalu Lintas. Skripsi, Jurusan Matematika, Fakultas 

Matematika dan Ilmu Pengetahuan Alam, Universitas Negeri Semarang. Pembimbing 

Utama Dr. Mulyono, M.Si, dan Pembimbing Pendamping Dr. Rochmad, M.Si. 

 

Kata Kunci : Algoritma Bee Colony, Metode Fuzzy Mamdani, Fase Lampu Lalu Lintas, 

Durasi Lampu Lalu Lintas, Fuzzy Logic Toolbox Matlab R2014a. 

 

 Algoritma Bee Colony adalah algoritma yang terinspirasi dari perilaku lebah dalam 

suatu kelompok untuk mencari makanan, dan dalam penelitian ini algoritma Bee Colony 

diimplementasikan untuk mengatur fase lampu lalu lintas di persimpangan simpang empat 

Jl. Tambak Dalam Raya- Jl. Soekarno Hatta- Jl. Gajah Raya dengan menggunakan prinsip 

pewarnaan simpul. Setelah fase lampu lalu lintas baru diperoleh kemudian diatur durasi 

lampu hijau menggunakan metode fuzzy mamdani. Metode fuzzy mamdani adalah salah 

satu  metode dalam FIS yang digunakan untuk memetakan suatu ruang input ke dalam suatu 

ruang output.  

 Permasalahan  yang diambil dalam penelitian ini adalah bagaimana implementasi 

algoritma Bee Colony dalam pengaturan fase lampu lalu lintas di persimpangan simpang 

empat Jl. Tambak Dalam Raya- Jl. Soekarno Hatta- Jl. Gajah Raya, bagaimana perhitungan 

durasi lampu lalu lintas pada fase lampu lalu lintas baru di persimpangan simpang empat 

Jl. Tambak Dalam Raya- Jl. Soekarno Hatta- Jl. Gajah Raya menggunakan metode Fuzzy 

Mamdani, dan bagaimana perbandingan sistem lalu lintas di persimpangan simpang empat 

Jl. Tambak Dalam- Jl. Soekarno Hatta- Jl. Gajah Raya sebelum dan sesudah diterapkan 

algoritma Bee Colony dengan Metode Fuzzy Mamdani. 

 Perhitungan durasi lampu hijau pada fase baru dengan menggunakan metode Fuzzy 

Mamdani dilakukan sebelum menghitung durasi lampu lalu lintas. Variabel input yang 

digunakan adalah variabel jumlag mobil dan motor yang berhenti saat lampu merah dan 

variabel outputnya adalah variabel durasi lampu hijau. Perhitungan durasi lampu hijau 

menggunakan bantuan fuzzy logic toolbox Matlab R2014a. Setelah diperoleh durasi lampu 

hijau maka dapat diperoleh durasi lampu lalu lintas, dengan durasi lampu kuning 2 detik 

dan durasi clear 3 detik. 

 Hasil penelitian diperoleh fase lampu lalu lintas baru yang tidak terjadi tabrakan 

antar arus dengan terdapat 4 fase didalamnya dan durasi lampu lalu lintas yang berubah 

mengikuti jumlah mobil dan motor yang berhenti saat lampu merah.  
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BAB 1 

PENDAHULUAN 

1.1 Latar Belakang 

Seiring dengan perkembangan zaman dan teknologi, semakin meningkat pula 

jumlah kendaraan bermotor. Jika peningkatan jumlah kendaraan bermotor tidak 

dibarengi dengan peningkatan prasarana transportasi, maka akan terjadi 

ketidakseimbangan antara permintaan dan persediaan, sehingga mengakibatkan 

kemacetan. Federal Highway Administration (2005), telah menjelaskan bahwa ada 

7 faktor yang menyebabkan kemacetan, salah satunya kemacetan yang dikarenakan 

alat pengaturan lalu lintas. Salah satu alat pengaturan lalu lintas adalah lampu lalu 

lintas yang terpasang di persimpangan. 

Lampu lalu lintas yang terpasang di persimpangan mempunyai beberapa 

tujuan antara lain menghindari hambatan karena adanya perbedaan arus jalan bagi 

pergerakan kendaraan, memfasilitasi pejalan kaki agar dapat menyebrang dengan 

aman dan tentunya mengurangi tingkat kecelakaan yang diakibatkan adanya 

tabrakan antar arus yang berbeda, karena fungsi lampu lalu lintas sangat penting 

maka dibutuhkan pengendalian dan pengontrolan sehingga dapat memperlancar 

lalu lintas di persimpangan. Namun sebagian besar pengaturan lampu lalu lintas 

pada saat ini masih kurang optimal karena masih ditemui adanya tabrakan antar 

arus kendaraan dan pengaturan durasi lampu hijau yang belum memperhatikan 

jumlah kendaraan yang berhenti saat lampu merah di persimpangan. 
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Kota Semarang termasuk kota besar, tentunya kota Semarang juga tidak 

terlepas dengan masalah kemacetan, ada beberapa persimpangan di kota Semarang 

yang masih belum optimal salah satunya di persimpangan simpang empat Jl. 

Tambak Dalam Raya- Jl. Soekarno Hatta- Jl. Gajah Raya. Persimpangan tersebut 

dikatakan kurang optimal, karena adanya tabrakan antar arus kendaraan dan durasi 

lampu lalu lintas disana konstan yang artinya pengaturan durasi lampu hijau belum 

memperhatikan jumlah kendaraan yang berhenti saat lampu merah di persimpangan 

tersebut. Fase lampu lalu lintas di persimpangan simpang empat Jl. Tambak Dalam 

Raya dapat dilihat pada Gambar 1.1.  

 

 

 

 

 

 

 

 

 

 

 

Gambar 1.1 Fase Lampu Lalu Lintas di Persimpangan Simpang Empat 

Jl. Tambak Dalam Raya- Jl. Soekarno Hatta- Jl. Gajah Raya, Kota Semarang 

Jl. Tambak Dalam 

Raya 

Jl. Gajah Raya 

SMPN 4 Semarang 
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Jawa Tengah 
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Keterangan: 
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= FASE 2 

= FASE 3 
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Terlihat arus- arus yang bertabrakan pada fase lampu lalu lintas saat ini adalah 

arus yang berada pada fase 1, yaitu arus kendaraan dari ruas Jl. Tambak Dalam 

Raya dengan arus kendaraan dari ruas Jl. Gajah Raya.  

Pewarnaan graf merupakan salah satu bagian dari teori graf. Francis Guthrie 

merupakan ahli matematika pertama yang melakukan penelitian tentang pewarnaan 

graf pada tahun 1852. Pewarnaan graf bukan hanya memberikan warna yang 

berbeda antar dua simpul yang bertetangga, tetapi warna yang dihasilkan minimum. 

Ada tiga macam pewarnaan graf yaitu pewarnaan simpul (vertex), pewarnaan sisi 

(edge) dan pewarnaan wilayah (region). Pada kasus pengaturan fase lampu lalu 

lintas di persimpangan, untuk diperoleh fase lampu lalu lintas tanpa adanya 

tabrakan antar arus kendaraan, merupakan pengaplikasian dari pewarnaan simpul.  

Algoritma Bee Colony adalah algoritma yang terinspirasi dari perilaku lebah 

dalam suatu kelompok untuk mencari makanan (Sireesha, 2014: 39). Dalam kasus 

pewarnaan algoritma Bee Colony sering digunakan untuk mengatur penjadwalan 

mata pelajaran, algoritma Bee Colony juga dapat digunakan untuk kasus lain, yaitu 

kasus Travelling Salesman Problem. 

Logika fuzzy pertama kali diusulkan oleh Lotfi A. Zadeh dari Universitas 

California pada tahun 1965. Selama 2 dekade logika fuzzy dianggap sebagai 

teknologi kontroversial, dan akhirnya dapat diterima sebagai teknologi baru sejak 

akhir 1980an, disebabkan oleh beragam aplikasi dari logika fuzzy yang sukses 

mulai dari pengendalian proses industri hingga aplikasi otomotif (Kamboj & Kaur, 

2013: 204). Menurut Kusumadewi & Purnomo (2010: 1), logika fuzzy adalah suatu 

cara yang tepat untuk memetakan suatu ruang input ke dalam suatu ruang output. 
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Salah satu aplikasi logika Fuzzy yang telah dikembangkan adalah Fuzzy Inference 

System (FIS), yaitu sistem komputasi yang bekerja atas dasar prinsip logika Fuzzy. 

Salah satu metode dalam FIS yaitu metode Mamdani atau sering disebut metode 

MAX-MIN. Pada kasus pengaturan durasi lampu hijau di persimpangan, variabel 

input yang digunakan adalah jumlah kendaraan yang berhenti saat lampu merah dan 

variabel outputnya adalah durasi lmpu hijau. 

Algoritma Bee Colony telah digunakan Faraji dan Javadi (2011) untuk 

masalah perwarnaan graf namun belum diterapkan dalam masalah aplikatifnya. 

Lara, Flores dan Calderon (2014) menggunakan algoritma Bee Colony untuk 

menyelesaikan masalah penjadwalan kelas dan guru. Rachmawati, Armay dan 

Purnomo (2012) juga menggunakan algoritma yang sama untuk menyelesaikan 

masalah penjadwalan kuliah di ITS, digunakan juga oleh Tanadi (2013) untuk 

menyelesaikan model penjadwalan guru menggunakan pewarnaan graf, dengan 

algoritma yang sama digunakan oleh Arifin dan Laksito (2019) dan Hermawan, 

Hidayat dan Setiawan (2017) dalam masalah Travelling Salesman Problem untuk 

mencari rute terpendek, yang mana bukan merupakan masalah pewarnaan graf.  

Kasus pengaturan lampu lalu lintas telah diselesaikan oleh Meiliana dan 

Maryono (2014) di Sukoharjo namun dengan algoritma yang berbeda yaitu 

algoritma Welch-Powell. Algoritma Welch-Powell juga digunakan Setiawan (2016) 

untuk menyelesaikan masalah pewarnaan graf di persimpangan Jerakah dan 

persimpangan STIKES Tlogorejo, Semarang. Marpaung (2019) menyelesaikan 

masalah pengaturan lampu lalu lintas mengunakan algoritma Recursive Large First.  
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Penelitian dari Meiliana dan Maryono (2014), Setiawan (2016) dan Marpaung 

(2019) mengambil studi kasus di persimpangan yang sudah bagus, ditunjukkan dari 

tidak adanya tabrakan antar arus kendaraan di persimpangan yang diteliti. 

Penelitian Meilina dan Maryono (2014), setiawan (2016), dan Marpaung (2019) 

tidak hanya mengatur fase lampu lalu lintas namun juga mengatur durasi lampu lalu 

lintas hanya saja dalam menghitung durasi lampu lalu lintas di persimpangan yang 

diteliti belum memperhatikan jumlah kendaraan yang berhenti saat lampu merah di 

persimpangan.  

Trimartanti dan Abadi (2015) dan Yudanto, Apriyadi dan Sanjaya (2013), dua 

penelitian ini menggunakan metode Fuzzy Mamdani untuk mengatur durasi lampu 

hijau menyala dengan memperhatikan jumlah mobil dan motor yang berhenti saat 

lampu merah di persimpangan, dalam penelitian  Trimartanti dan Abadi (2015) dan 

Yudanto, Apriyadi dan Sanjaya (2013) ukuran jalan di persimpangan diasumsikan 

memiliki ukuran yang sama.  

Perbedaan penelitian penulis dengan penelitian terdahulu adalah menerapkan 

prinsip pewarnaan simpul dengan algoritma Bee Colony untuk mengatur fase lampu 

lalu lintas di persimpangan simpang empat Jl. Tambak Dalam Raya- Jl. Soekarno 

Hatta- Jl. Gajah Raya, Kota Semarang, penelitian ini memilih persimpangan yang 

masih ditemui adanya tabrakan antar arus kendaraan, penelitian ini juga mengatur 

durasi lampu lalu lintas pada fase lampu lalu lintas baru dengan terlebih dahulu 

menghitung durasi lampu hijau menggunakan metode fuzzy Mamdani dengan 

memperhatikan jumlah mobil dan jumlah motor yang berhenti saat lampu merah di 

persimpangan yang diteliti.  
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Perbedaan lain dengan penelitian sebelumnya adalah penelitian sebelumnya 

algoritma Bee Colony digunakan untuk masalah penjadwalan mata pelajaran dan 

masalah travelling salesman problem,  dalam kasus pengaturan lampu lalu lintas 

penelitian sebelumnya diselesaikan dengan algoritma lain yang dalam menghitung 

durasi lampu hijau belum memperhatikan jumlah kendaraan yang berhenti saat 

lampu merah persimpangan yang diteliti. 

Berdasarkan latar belakang permasalahan di atas, penulis mengangkat judul 

“Implementasi Algoritma Bee Colony dengan metode Fuzzy Mamdani untuk 

Pengaturan Lampu Lalu Lintas”. 

1.2 Rumusan Masalah  

Berdasarkan latar belakang yang telah disusun di atas maka dapat ditarik 

beberapa permasalahan sebagai berikut. 

1. Bagaimana implementasi algoritma Bee Colony dalam pengaturan fase lampu 

lalu lintas di persimpangan simpang empat Jl. Tambak Dalam Raya- Jl. 

Soekarno Hatta- Jl. Gajah Raya? 

2. Bagaimana perhitungan durasi lampu lalu lintas pada fase lampu lalu lintas 

baru di persimpangan simpang empat Jl. Tambak Dalam Raya- Jl. Soekarno 

Hatta- Jl. Gajah Raya menggunakan metode Fuzzy Mamdani? 

3. Bagaimana perbandingan sistem lampu lalu lintas di persimpangan simpang 

empat Jl. Tambak Dalam- Jl. Soekarno Hatta- Jl. Gajah Raya sebelum dan 

sesudah diterapkan algoritma Bee Colony dengan metode Fuzzy Mamdani? 
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1.3 Tujuan Penelitian 

Tujuan dari penelitian ini adalah 

1. Mengetahui implementasi algoritma Bee Colony dalam pengaturan fase lampu 

lalu lintas di persimpangan simpang empat Jl. Tambak Dalam Raya- Jl. 

Soekarno Hatta- Jl. Gajah Raya. 

2. Menentukan durasi lampu lalu lintas pada fase lampu lalu lintas baru di 

persimpangan simpang empat Jl. Tambak Dalam Raya- Jl. Soekarno Hatta- Jl. 

Gajah Raya menggunakan metode Fuzzy Mamdani. 

3. Mencari perbandingan antara sistem lampu lalu lintas di persimpangan 

simpang empat Jl. Tambak Dalam Raya- Jl. Soekarno Hatta- Jl. Gajah Raya 

sebelum dan sesudah diterapkan algoritma  Bee Colony dengan Metode Fuzzy 

Mamdani. 

1.4 Batasan Masalah  

Batasan masalah yang dilakukan pada penelitian ini adalah sebagai berikut 

1. Tempat penelitian di persimpangan simpang empat Jl. Tambak Dalam- Jl. 

Soekarno Hatta- Jl. Gajah Raya , Kota Semarang  

2. Data diambil dalam 3 waktu, pukul 06.00-08.00, pukul 11.30-13.30 dan pukul 

15.30-17.30. 

3. Variabel input yang digunakan dalam metode Fuzzy Mamdani adalah jumlah 

mobil dan motor yang berhenti saat lampu merah di fase yang diatur, sehingga 

jumlah mobil dan motor tiap fasenya jelas. Jumlah mobil dan motor yang 

diinputkan tidak melebihi jumlah maksimum. 
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4. Ukuran mobil pada penelitian ini digunakan ukuran standar mobil ditambah 

ruang antara kendaraan yaitu  2.5 𝑚 × 5 𝑚 dan ukuran motor digunakan 

ukuran standar motor ditambah ruang antara kendaraan yaitu 1 𝑚 × 2.5 𝑚, 

karena berdasarkan penelitian jumlah intensitas mobil dan motor rata-rata 

memiliki ukuran tersebut. Penambahan ruang antara kendaraan bertujuan 

agar mobil maupun motor tidak berhimpitan satu dengan yang lain. Sehingga 

keadaan persimpangan dalam perhintungan dalam keadaan ideal. 

1.5 Batasan Istilah 

a. Algoritma Bee Colony 

Algoritma Bee Colony adalah algoritma yang dibuat berdasarkan tingkah laku 

lebah dalam suatu kelompok untuk mencari sumber makanan (nektar) (Safitri, 

2014). Algoritma Bee Colony tidak hanya mampu menyelesaikan kasus travelling 

salesman problem namun juga mampu menyelesaikan dengan baik kasus 

pewarnaan simpul graf. Dalam penelitian ini algoritma Bee Colony digunakan 

untuk menyelesaikan masalah pewarnaan graf di persimpangan simpang empat Jl. 

Tambak Dalam Raya- Jl. Soekarno Hatta- Jl. Gajah Raya. 

b. Metode Fuzzy Mamdani 

Metode Fuzzy Mamdani adalah salah satu metode dalam Fuzzy Inference 

System (FIS) yaitu suatu kerangka komputasi yang didasarkan pada teori himpunan 

fuzzy, aturan fuzzy berbentuk IF-THEN, dan penalaran fuzzy (Kusumadewi & 

Hartati, 2010: 40). Dalam penelitian ini metode fuzzy Mamdani digunakan untuk 

menghitung durasi lampu hijau di persimpangan simpang empat Jl. Tambak Dalam- 
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Jl. Soekarno Hatta- Jl. Gajah Raya dengan memperhatikan jumlah mobil dan motor 

yang berhenti saat lampu merah. 

c.  Logika Fuzzy 

Logika fuzzy adalah suatu cara yang tepat untuk memetakan suatu ruang 

input ke dalam suatu ruang output (Kusumadewi, 2010: 1). Dalam penelitian ini 

variabel input berupa jumlah mobil dan motor yang berhenti saat lampu merah di 

fase yang diatur dan variabel output berupa durasi lampu hijau di fase yang diatur 

pada persimpangan simpang empat Jl. Tambak Dalam Raya- Jl. Soekarno Hatta- Jl. 

Gajah Raya. 

d.  Persimpangan Jalan 

 Menuut MKJI (1997), persimpangan adalah dua buah ruas jalan atau lebih 

yang saling bertemu, saling berpotongan, atau saling bersilangan. Persimpangan 

merupakan tempat sumber konflik  lalu  lintas  yang  rawan  terhadap kecelakaan 

karena  terjadi konflik  antara kendaraan  dengan  kendaraan  lainnya  ataupun  

antara  kendaraan  dengan  pejalan kaki.  Dalam penelitian ini, persimpangan jalan 

yang  diamati  yaitu  persimpangan simpang empat Jl. Tambak Dalam Raya- Jl. 

Soekarno Hatta- Jl. Gajah Raya. 

e. Lampu Lalu Lintas 

Lampu lalu lintas (traffic light) adalah perangkat sinyal yang terletak di titik 

persimpangan jalan yang digunakan untuk mengendalikan penyelesaian arus lalu 

lintas (Kham & Nwe, 2014: 1). Lampu lalu lintas yang terdapat di persimpangan 

mempunyai beberapa tujuan antara lain menghindari hambatan karena adanya 

perbedaan arus jalan bagi pergerakan kendaraan, memfasilitasi pejalan kaki agar 
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dapat menyebrang dengan aman dan tentunya mengurangi tingkat kecelakaan yang 

diakibatkan adanya tabrakan antar arus yang berbeda.  

Dalam penelitian ini lampu lalu lintas yang diamati adalah lampu lalu lintas 

yang terdapat di persimpangan simpang empat Jl. Tambak Dalam Raya- Jl. 

Soekarno Hatta- Jl. Gajah Raya.  

f.  Fase Lampu Lalu Lintas 

Fase adalah rangkaian isyarat yang dipergunakan untuk mengurus arus 

kendaraan untuk diperbolehkan bergerak atau berhenti (Bien et al., 2019:115). 

Dalam penelitian ini fase lampu lalu lintas yang diatur adalah fase lampu lalu lintas 

di persimpangan simpang empat Jl. Tambak Dalam Raya- JL. Soekarno Hatta- Jl. 

Gajah Raya. 

g.  Durasi Lampu Lalu Lintas 

 Durasi lalu lintas adalah lama kendaraan dapat bergerak ataupun berhenti 

berdasarkan waktu yang telah ditentukan. Dalam penelitian ini durasi lampu lalu 

lintas pada persimpangan simpang empat Jl. Tambak Dalam Raya- Jl. Soekarno 

Hatta- Jl. Gajah Raya diatur menggunakan metode Fuzzy Mamdani. 

h. Sistem Lampu Lalu Lintas 

 Sistem lampu lalu lintas adalah sistem pengaturan kerja lampu lalu lintas 

untuk menghasilkan sistem yang mampu mengurangi resiko kemacetan dan 

memberikan rasa aman bagi pengguna jalan. Dalam penelitian ini sistem lalu lintas 

yang diatur adalah sistem lalu lintas pada persimpangan simpang empat Jl. Tambak 

Dalam Raya- Jl. Soekarno Hatta- Jl. Gajah Raya, dengan mengatur fase lampu lalu 

lintas dan durasi pada fase baru di persimpangan tersebut. 
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i. Fuzzy Logic Toolbox 

Fuzzy logic toolbox adalah sekumpulan tool yang membantu merancang 

sistem fuzzy (Naba, 2009). Dalam penelitian ini menggunakan fuzzy logic toolbox 

pada Matlab R2014a untuk menghitung durasi lampu hijau pada persimpangan 

simpang empat Jl. Tambak Dalam Raya- Jl. Soekarno Hatta- Jl. Gajah Raya. 

1.6 Manfaat Penelitian 

Manfaat penelitian ini adalah  

1. Menambah wawasan pengetahuan penulis tentang algoritma Bee Colony dan 

penggunaanya, khususnya untuk menyelesaikan kasus pewarnaan simpul 

untuk mencari fase lampu lalu lintas di persimpangan jalan. Serta menambah 

wawasan pengetahuan penulis tentang Metode Fuzzy Mamdani untuk mencari 

durasi lampu lalu lintas di persimpangan jalan dengan memperhatikan jumlah 

mobil dan motor yang berhenti saat lampu merah. 

2. Menjadi bahan masukan bagi Dinas Perhubungan, Komunikasi, dan 

Informatika (DISHUBKOMINFO) Kota Semarang untuk mengatur fase dan 

durasi lampu lalu lintas di persimpangan simpang empat Jl. Tambak Dalam 

Raya- Jl. Soekarno Hatta- Jl. Gajah Raya. 

3. Sebagai refrensi bagi mahasiswa Jurusan Matematika Fakultas MIPA UNNES. 

1.7 Sistematika Penulisan Skripsi 

Secara garis besar skripsi ini dibagi menjadi tiga bagian yaitu bagian awal 

skripsi, bagian isi skripsi, dan bagian akhir skripsi. 
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1. Bagian awal skripsi 

Bagian awal skripsi meliputi halaman judul, pernyataan keaslian tulisan, 

pengesahan, motto dan persembahan, prakata, abstrak, daftar isi, daftar gambar, 

daftar tabel, dan daftar lampiran. 

2. Bagian isi skripsi 

Bagian isi skripsi secara garis besar terdiri dari lima bab, yaitu sebagai 

berikut. 

BAB 1. PENDAHULUAN 

Bab ini berisi mengenai latar belakang, rumusan masalah, tujuan penelitian, 

batasan masalah, batasan istilah, manfaat penelitian, dan sistematika 

penulisan skripsi. 

BAB 2. TINJAUAN PUSTAKA 

Bab ini berisi kajian teori yang mendasari dan berhubungan dengan 

pemecahan masalah. Teori-teori tersebut digunakan untuk memecahkan 

masalah yang diangkat dalam skripsi ini. Teori yang digunakan adalah Graf,  

Pewarnaan Simpul, Algoritma Bee Colony, Logika Fuzzy, Metode Fuzzy 

Mamdani, Fuzzy Logic Toolbox Matlab R2014a dan Pengaturan Lampu 

Lalu Lintas . 

BAB 3. METODE PENELITIAN 

Bab ini berisi tentang metode-metode yang digunakan dalam penelitian 

yang meliputi indentifikasi masalah, studi pustaka, penentuan objek 

penelitian, pengumpulan data, penyelesaian masalah, dan penarikan 

kesimpulan. 
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BAB 4. HASIL PENELITIAN DAN PEMBAHASAN 

Bab ini berisi semua hasil penelitian dan pembahasan mengenai 

implementasi algoritma Bee Colony dengan metode Fuzzy Mamdani untuk 

pengaturan lampu lalu lintas di persimpangan simpang empat Jl. Tambak 

Dalam Raya- Jl. Soekarno Hatta- Jl. Gajah Raya, kota Semarang. 

Pengaturan lampu lalu lintas yang dimaksudkan dalam penelitian ini berupa 

pegaturan fase lampu lalu lintas agar tidak terjadi tabrakan antar arus 

kendaraan dan mengatur durasi lampu lalu lintas pada fase lampu lalu lintas 

baru dengan terlebih dahulu menghitung durasi lampu hijau yang 

memperhatikan jumlah mobil dan motor yang berhenti saat lampu merah. 

Penelitian ini menampilkan perbandingan antara sistem lampu lalu lintas 

saat ini dengan sistem lampu lalu lintas baru sebelum dan sesudah 

menggunakan algoritma Bee Colony dan metode Fuzzy Mamdani. 

BAB 5. PENUTUP 

Bab ini berisi tentang simpulan dan saran- saran yang diberikan penulis 

berdasarkan simpulan 

3. Bagian akhir skripsi 

Bagian akhir skripsi meliputi daftar pustaka dan lampiran- lampiran yang 

mendukung skripsi. 
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BAB 2 

TINJAUAN PUSTAKA 

2.1  Graf 

Graf 𝐺 didefinisikan sebagai pasangan himpunan (𝑉, 𝐸), ditulis dengan notasi 

𝐺 = (𝑉, 𝐸), yang dalam hal ini 𝑉 adalah himpunan tidak kosong dari simpul- 

simpul dan 𝐸 adalah himpunan boleh kosong dari sisi- sisi yang menghubungkan 

sepasang simpul (Munir, 2010:356). 

Dikatakan graf apabila paling sedikit memiliki satu titik dan boleh tidak 

memiliki sisi. Graf yang hanya memiliki n titik dan tidak memiliki sisi disebut graf 

kosong/ graf nol, dilambangkan 𝑁𝑛. Sedangkan graf yang memiliki n titik dan 

setiap dua titik yang berbeda dihubungkan dengan sebuah sisi dinamakan graf 

komplit/ graf lengkap. 

Dalam pembahasan mengenal graf sering menggunakan terminologi yang 

berkaitan dengan graf (Munir, 2010: 364). Berikut beberapa terminologi yang 

berkaitan dengan graf. 

a.  Bertetangga (Adjacent) 

Dua buah simpul dikatakan bertetangga bila keduanya terhubung langsung 

dengan sebuah sisi. Dengan kata lain, 𝑢 bertetangga dengan 𝑣 jika (𝑢, 𝑣) adalah 

sebuah sisi pada graf 𝐺 (Munir, 2010: 365). 
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b. Bersisian (Incident) 

 Suatu sisi 𝑒 dikatakan bersisian dengan simpul 𝑣1 dan simpul 𝑣2 jika 𝑒 

merupakan sisi yang terkait dengan kedua simpul tersebut, dengan kata lain 𝑒 =

(𝑣1, 𝑣2) (Adiwijaya, 2016: 98). 

c.  Simpul Terpencil (Isolated Vertex)  

 Simpul terpencil adalah simpul yang tidak mempunyai sisi yang bersisian 

dengannya atau simpul yang tidak satupun bertetangga dengan simpul- simpul lain 

(Munir, 2010: 365). 

d. Derajat (Degree)  

 Derajat suatu simpul adalah jumlah sisi yang bersisian dengan simpul 

tersebut, 𝑑(𝑣) menyatakan derajat simpul 𝑣 (Munir, 2010: 366). 

Contoh 2.1 

Misalkan dipunyai sebuah graf 𝐺 dengan 5 simpul, disajikan pada Gambar 2.1. 

 

 

 

 

Gambar 2.1 Graf 𝐺 dengan 5 simpul 

Keterangan: 

a. Himpunan simpul pada graf 𝐺 yaitu 𝑉(𝐺) = {𝑣1, 𝑣2, 𝑣3, 𝑣4, 𝑣5} 

b. Himpunan sisi pada graf 𝐺 yaitu 𝐸(𝐺) = {𝑒1, 𝑒2, 𝑒3, 𝑒4} 

c. Simpul 𝑣1 bertetangga dengan simpul 𝑣3, 𝑣4 dan 𝑣5, simpul 𝑣3 bertetangga 

dengan simpul 𝑣1 dan 𝑣5, simpul 𝑣4 bertetangga dengan simpul 𝑣1, dan simpul 

𝑣5 bertetangga dengan simpul 𝑣1 dan 𝑣3. 

𝑒1 
𝑒3 

𝑒4 

𝑣1 

𝑣3 

𝑣4 

𝑣5 

𝑣2 

𝑒2 
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d. Sisi 𝑒1 bersisian dengan simpul 𝑣1, dan 𝑣3, sisi 𝑒2 bersisian dengan simpul 𝑣3 

dan 𝑣5, sisi 𝑒3 bersisian dengan simpul 𝑣1 dan 𝑣5, dan sisi 𝑒4 bersisian dengan 

simpul 𝑣1 dan 𝑣4. 

e. Simpul 𝑣2 adalah simpul terpencil 

2.2 Pewarnaan Simpul 

Pewarnaan simpul adalah menetapkan warna pada masing- masing simpul di 

dalam graf sedemikian sehingga warna pada simpul-simpul yang bertetangga 

memiliki warna berbeda (Patidar & Chakrabarti, 2016: 403). 

Suatu graf 𝐺 dikatakan berwarna 𝑘 jika terdapat 𝑘 warna dalam pewarnaan 

graf 𝐺. Banyak warna minimum yang diperlukan dalam pewarnaan suatu graf 

dinamakan bilangan khromatik, yang dinotasikan 𝜒(𝐺) (Adiwijaya: 169). 

Misalkan 𝐺 sebuah graf. Bilangan khromatik pada graf 𝐺 disimbolkan 𝜒(𝐺), 

didefinisikan sebagai 𝜒(𝐺) =min {𝑘|ada pewarnaan-𝑘 pada 𝐺} (Budayasa, 

2007:152). 

2.3 Algoritma Bee Colony 

Algoritma Bee Colony adalah algoritma yang terinspirasi oleh perilaku lebah 

madu dalam suatu kelompok untuk mencari makanan (Sireesha, 2014: 39).  

Dalam penelitian ini kasus pewarnaan simpul dalam pengaturan lampu lalu 

lintas tidak ada kendala banyaknya simpul untuk suatu warna, maka langkah 

pewarnaan simpul dengan algoritma Bee Colony dalam kasus ini adalah sebagai 

berikut: 

1.  Pewarnaan simpul pertama random 

2.  Pewarnaan simpul berikutnya dicari dengan menggunakan fungsi probabilitas: 
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𝑃𝑣𝑖,𝑆 = {

0, 𝑣𝑖 ∈ 𝑊𝑆
𝑑(𝑣𝑖)

∑ 𝑑(𝑣𝑗)𝑁
𝑗=1,𝑣𝑗∉𝑊𝑆

, 𝑣𝑖 ∉ 𝑊𝑆
      (2.1) 

𝑃𝑣𝑖,𝑆 adalah probabilitas simpul 𝑣𝑖 yang dipilih, 𝑊𝑆 adalah himpunan dari simpul 

berwarna, 𝑁 adalah jumlah simpul dalam graf, 𝑤𝑆(𝑣𝑖) adalah simpul 𝑣𝑖 yang 

berwarna, dan 𝑊 adalah himpunan warna. 

3. Ulangi langkah 2 sampai semua simpul terwarnai 

Contoh 2.2 

Misalkan 𝐺 suatu graf persimpangan simpang tiga, disajikan pada Gambar 2.2. 

 

 

 

Gambar 2.2 Graf G, Graf Persimpangan Simpang Tiga 

Langkah –langkah penyelesaian pewarnaan simpul pada graf 𝐺 dengan algoritma 

Bee Colony: 

1.  Diasumsikan simpul pertama yang diberi warna adalah simpul 𝑣2, maka 𝑊𝑆 =

{𝑤𝑠(𝑣2)} dan 𝑊 = {𝑊1}. 

2.  Pewarnaan simpul ke -2 

 Simpul yang bertetangga dengan simpul 𝑣2 adalah simpul 𝑣4, 𝑣5, dan 𝑣6, 

sehingga untuk pewarnaan simpul ke-2 menggunakan fungsi probabilitas pada 

persamaan (2.1) 

𝑃𝑣𝑖,𝑆 =
𝑑(𝑣𝑖)

∑ 𝑑(𝑣𝑗)𝑁
𝑗=1,𝑣𝑗∉𝑊𝑆

 untuk 𝑣𝑖 ∉ 𝑊𝑆 

𝑣2 

𝑣4 

𝑣5 

𝑣6 

𝑣3 

𝑣1 
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Untuk simpul 𝑣4 

 𝑃𝑣4,𝑆 =
𝑑(𝑣4)

∑ 𝑑(𝑣𝑗)6
𝑗=1,𝑣𝑗∉𝑊𝑆

 

 𝑃𝑣4,𝑆 =
𝑑(𝑣4)

𝑑(𝑣1)+𝑑(𝑣3)+𝑑(𝑣4)+𝑑(𝑣5)+𝑑(𝑣6)
 

 𝑃𝑣4,𝑆 =
2

0+0+2+1+2
 

 𝑃𝑣4,𝑆 =
2

5
 

Untuk simpul 𝑣5 

 𝑃𝑣5,𝑆 =
𝑑(𝑣5)

∑ 𝑑(𝑣𝑗)6
𝑗=1,𝑣𝑗∉𝑊𝑆

 

 𝑃𝑣5,𝑆 =
𝑑(𝑣5)

𝑑(𝑣1)+𝑑(𝑣3)+𝑑(𝑣4)+𝑑(𝑣5)+𝑑(𝑣6)
 

 𝑃𝑣5,𝑆 =
1

0+0+2+1+2
 

 𝑃𝑣5,𝑆 =
1

5
 

Untuk simpul 𝑣6 

 𝑃𝑣6,𝑆 =
𝑑(𝑣6)

∑ 𝑑(𝑣𝑗)6
𝑗=1,𝑣𝑗∉𝑊𝑆

 

 𝑃𝑣6,𝑆 =
𝑑(𝑣6)

𝑑(𝑣1)+𝑑(𝑣3)+𝑑(𝑣4)+𝑑(𝑣5)+𝑑(𝑣6)
 

 𝑃𝑣6,𝑆 =
2

0+0+2+1+2
 

 𝑃𝑣6,𝑆 =
2

5
 

Karena nilai probabilitas 𝑣4, dan 𝑣6  lebih besar dari nilai probabilitas 𝑣5 yaitu 
2

5
, 

maka dapat dipilih salah satu simpul dari 𝑣4, dan 𝑣6 untuk diberi warna yaitu 𝑣4. 

Warna dari simpul 𝑣4 tidak boleh sama dengan warna pada 𝑣2 karena 

bertetangga. Sehingga 𝑊𝑠 = {𝑤𝑠(𝑣2), 𝑤𝑠(𝑣4)} dan 𝑊 = {𝑊1, 𝑊2}. 
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3.  Pewarnaan simpul ke-3 

Simpul yang bertetangga dengan 𝑣4 dan bukan simpul yang telah diwarnai 

adalah simpul 𝑣6 Sehingga dapat langsung diberi warna. Warna dari simpul 𝑣6 

tidak boleh sama dengan warna pada 𝑣2 dan 𝑣4 karena bertetangga. Sehingga 

𝑊𝑠 = {𝑤𝑠(𝑣2), 𝑤𝑠(𝑣4), 𝑤𝑠(𝑣6)} dan 𝑊 = {𝑊1, 𝑊2, 𝑊3}. 

4.  Pewarnaan simpul ke-4 

Simpul yang bertetangga dengan 𝑣6 dan bukan simpul yang telah diwarnai tidak 

ada, maka untuk pewarnaan selanjutnya dicari simpul lain yang belum diberi 

warna yaitu simpul 𝑣1, 𝑣3, dan 𝑣5. Pemberian warna pada simpul tersebut 

menggunakan fungsi probabilitas sesuai persamaan (2.1). 

Untuk simpul 𝑣1 

 𝑃𝑣1,𝑆 =
𝑑(𝑣1)

∑ 𝑑(𝑣𝑗)6
𝑗=1,𝑣𝑗∉𝑊𝑆

 

 𝑃𝑣1,𝑆 =
𝑑(𝑣1)

𝑑(𝑣1)+𝑑(𝑣3)+𝑑(𝑣5)
 

 𝑃𝑣1,𝑆 =
0

0+0+1
 

 𝑃𝑣1,𝑆 = 0 

Untuk simpul 𝑣3 

 𝑃𝑣3,𝑆 =
𝑑(𝑣3)

∑ 𝑑(𝑣𝑗)6
𝑗=1,𝑣𝑗∉𝑊𝑆

 

 𝑃𝑣3,𝑆 =
𝑑(𝑣3)

𝑑(𝑣1)+𝑑(𝑣3)+𝑑(𝑣5)
 

 𝑃𝑣3,𝑆 =
0

0+0+1
 

 𝑃𝑣3,𝑆 = 0 
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Untuk simpul 𝑣5 

 𝑃𝑣5,𝑆 =
𝑑(𝑣5)

∑ 𝑑(𝑣𝑗)6
𝑗=1,𝑣𝑗∉𝑊𝑆

 

 𝑃𝑣5,𝑆 =
𝑑(𝑣5)

𝑑(𝑣1)+𝑑(𝑣3)+𝑑(𝑣5)
 

 𝑃𝑣5,𝑆 =
1

0+0+1
 

 𝑃𝑣5,𝑆 = 1 

Karena nilai probabilitas 𝑣5 lebih besar dari nilai probabilitas 𝑣1 dan 𝑣3 yaitu 1, 

maka simpul 𝑣5 dapat diberi warna. Warna simpul 𝑣5 tidak boleh sama dengan 

warna simpul 𝑣2 karena bertetangga, namun warna simpul 𝑣5 dapat diberi warna 

yang sama dengan simpul 𝑣4 dan 𝑣6. Simpul 𝑣5 diberi warna yang sama dengan 

warna simpul 𝑣4. Sehingga 𝑊𝑠 = {𝑤𝑠(𝑣2), 𝑤𝑠(𝑣4), 𝑤𝑠(𝑣5), 𝑤𝑠(𝑣6)} dan 𝑊 =

{𝑊1, 𝑊2, 𝑊2, 𝑊3}. 

Simpul yang bertetangga dengan 𝑣5 dan bukan simpul yang telah diwarnai tidak 

ada, maka untuk pewarnaan selanjutnya dicari simpul lain yang belum diberi 

warna yaitu simpul 𝑣1,  dan 𝑣3. Karena simpul 𝑣1,  dan 𝑣3 adalah simpul 

terpencil dalam graf persimpangan maka simpul  𝑣1,  dan 𝑣3 berlaku terus lampu 

hijau sehingga simpul 𝑣1,  dan 𝑣3 tidak perlu diberi warna. 

5. Setiap simpul yang bukan simpul terpencil telah diberi warna dan tidak ada 

simpul-simpul yang bertetangga memiliki warna yang sama, maka prosedur 

berhenti. 

Solusi pewarnaan simpul pada graf 𝐺 graf persimpangan simpang tiga, 

disajikan pada Tabel 2.1. 
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Tabel 2.1 Solusi Pewarnaan Simpul pada 𝐺 

 

 

keterangan : 

 𝑊1= hijau 

𝑊2= biru 

𝑊3= merah 

- = hitam, artinya simpul yang diberi warna hitam adalah simpul terpencil dan 

arus kendaraan yang dipresentasikan oleh simpul yang berwarna hitam adalah 

arus kendaraan belok kiri jalan terus, sehingga pewarnaan simpul pada simpul 

terpencil tidak berpengaruh pada simpul lain. Dalam kasus ini adalah simpul 

𝑣1 dan 𝑣3. 

Berikut graf penyelesaian dari graf 𝐺 graf persimpangan simpang tiga, disajikan 

pada Gambar 2.3. 

 

 

 

 

 

 

Gambar 2.3 Graf Penyelesaian dari Graf 𝐺 Graf Persimpangan Simpang Tiga 

Gambar 2.3 menunjukkan antar dua simpul yang bertetangga memiliki warna yang 

berbeda. Arus kendaraan yang dipresentasikan oleh simpul 𝑣4 dan 𝑣5 dapat berjalan 

bersamaan karena memiliki warna yang sama yaitu warna biru, sedangkan arus 

kendaraan yang dipresentasikan oleh simpul 𝑣2 berjalan sendiri seperti dengan 

Simpul 𝑣1 𝑣2 𝑣3 𝑣4 𝑣5 𝑣6 

Warna - 𝑊1 - 𝑊2 𝑊2 𝑊3 

𝑣2 

𝑣4 

𝑣5 

𝑣6 

𝑣3 

𝑣1 
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simpul 𝑣6 karena tidak ada simpul lain yang memilik warna yang sama dengan 

simpul 𝑣2 maupun simpul 𝑣6. Warna hitam pada simpul 𝑣1 dan simpul 𝑣3 

menandakan bahwa simpul 𝑣1 dan simpul 𝑣3 adalah simpul terpencil dan simpul 𝑣1 

dan simpul 𝑣3 adalah simpul yang mempresentasikan arus kendaraan belok kiri 

jalan terus, sehingga warna hitam pada simpul 𝑣1 dan simpul 𝑣3 tidak berpengaruh 

pada simpul lain. Jadi ada 3 warna yang digunakan dalam pewarnaan simpul 

menggunakan algoritma Bee Colony di graf G graf persimpangan simpang tiga  

yaitu hijau, biru dan merah, sehingga diperoleh bilangan khromatik-3. 

2.4 Logika Fuzzy 

Logika fuzzy pertama kali diusulkan oleh Lotfi A. Zadeh dari Universitas 

California pada tahun 1965 (Kamboj & Kaur, 2013: 204). Logika fuzzy merupakan 

solusi pemecahan masalah ketidakpastian yang tepat (Naba, 2009), karena logika 

fuzzy bersifat fleksibel dan memberikan toleransi terhadap ketidakpresisian data 

(Santoso, 2017). Menurut Kusumadewi & Purnomo (2010:1-2), logika fuzzy adalah 

suatu cara yang tepat untuk memetakan suatu ruang input ke dalam suatu ruang 

output, ilustrasi dapat dilihat pada Gambar 2.4. 

 

 

Gambar 2.4 Pemetaan Suatu Ruang Input ke dalam Suatu Ruang Output 

Berdasarkan ilustrasi pada Gambar 2.4 black box atau kotak hitam berisi cara atau 

metode yang dapat digunakan untuk mengolah data input menjadi output, salah satu 

metode tersebut adalah logika fuzzy. 

 

Input Output Black Box 
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Kelebihan logika fuzzy dijelaskan oleh (Kusumadewi & Purnomo, 2010: 2-

3), sebagai berikut: 

1. Konsep logika fuzzy mudah dimengerti, karena logika fuzzy menggunakan 

konsep matematis yang sederhana sehingga mudah untuk dipahami. 

2. Logika fuzzy sangat fleksibel. 

3. Logika fuzzy memiliki toleransi terhadap data-data yang tidak tepat. 

4. Logika fuzzy mampu memodelkan fungsi-fungsi nonlinear yang sangat 

kompleks. 

5. Logika fuzzy dapat membangun dan mengaplikasikan pengalaman-

pengalaman para pakar secara langsung tanpa harus melalui proses pelatihan. 

6. Logika fuzzy dapat bekerjasama dengan teknik-teknik kendali secara 

konvensional. 

7. Logika fuzzy didasarkan pada bahasa alami. 

2.4.1 Himpunan Fuzzy 

Kusumadewi & Purnomo (2010: 3) menyatakan bahwa nilai keanggotaan 

pada himpunan crisp atau himpuanan tegas hanya memiliki dua kemungkinan yaitu 

0 atau 1, sedangkan pada himpunan fuzzy nilai keanggotaan terletak pada rentang 

0 sampai 1. Apabila 𝑥 memiliki nilai keanggotaan fuzzy 𝜇𝐴 [𝑥] = 0 berarti 𝑥 tidak 

menjadi himpuan 𝐴, demikian pula apabila 𝑥 memiliki nilai keanggotaan fuzzy 

𝜇𝐴 [𝑥] = 1 berarti menjadi anggota penuh himpunan 𝐴.  

 

 



24 
 

 
 

Dalam memahami logika fuzzy, adapun hal-hal yang perlu diketahui, adalah 

sebagai berikut: 

a. Variabel Fuzzy 

Variabel fuzzy adalah variabel yang akan dibahas dalam suatu sistem fuzzy, 

seperti: jumlah mobil, jumlah motor, durasi lampu hijau, berat badan, tinggi badan, 

dan sebagainya. 

b. Himpunan Fuzzy 

Himpunan fuzzy adalah suatu kelompok yang mewakili suatu keadaan 

tertentu dalam suatu variabel fuzzy. Menurut Kusumadewi & Purnomo (2010:6) 

himpunan fuzzy memiliki 2 atribut, yaitu: 

1) Linguistik, yaitu penamaan suatu kelompok yang mewakili suatu keadaan 

atau kondisi tertentu dengan menggunakan bahasa alami. 

2) Numeris, yaitu suatu nilai (angka) yang menunjukkan ukuran dari suatu 

variabel. 

c. Semesta Pembicaraan 

Semesta pembicaraan adalah keseluruhan nilai yang diperbolehkan untuk 

dioperasikan dalam suatu variabel fuzzy 

c. Domain 

Domain himpunan fuzzy adalah keseluruhan nilai yang dijinkan dalam 

semesta pembicaraan dan boleh dioperasikan dalam suatu himpunan fuzzy. 

Contoh 2.3 

Variabel kendaraan terbagi menjadi tiga himpunan fuzzy, yaitu: SEDIKIT, 

SEDANG, dan BANYAK, disajikan pada Gambar 2.5. 
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Gambar 2.5 Himpuan Fuzzy Variabel Kendaraan 

Keterangan : 

a. Variabel fuzzy berupa jumlah kendaraan 

b. Himpunan fuzzy linguistik : SEDIKIT, SEDANG, dan BANYAK 

c. Himpunan fuzzy numerius : nilai 0,5,30,60  

d. Semesta pembicaraan = [0,60] 

e. Domain untuk himpunan fuzzy SEDIKIT = [0,30] 

f. Domain untuk himpunan fuzzy SEDANG = [5,60] 

g. Domain untuk himpunan fuzzy BANYAK = [30,60] 

2.4.2 Fungsi Keanggotaan 

Fungsi keanggotaan (membership function) adalah suatu kurva yang 

menunjukkan pemetaan titik-titik input data ke dalam nilai keanggotaan yang 

memiliki interval antara 0 sampai 1. Beberapa fungsi keanggotaan yang dapat 

digunakan dalam logika fuzzy, adalah sebagai berikut: 

a. Representasi Linear 

Pemetaan input ke derajat keanggotaannya digambarkan sebagai suatu garis 

lurus. Bentuk ini paling sederhana dan menjadi pilihan yang baik untuk mendekati 

suatu konsep yang kurang jelas. Ada 2 keadaan himpunan fuzzy linear, disajikan 

pada Gambar 2.6 dan Gambar 2.7. 

1 

0 5 3
0 

6
0 

SEDIKIT SEDANG BANYAK 

kendaraan/ menit 

𝜇
  𝐾

𝐸
𝑁

𝐷
𝐴

𝑅
𝐴

𝐴
𝑁
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1. Representasi linear naik  

 

 

 

 

Gambar 2.6 Representasi Linear Naik 

Fungsi Keangggotaan: 

         

(2.2)  

2. Representasi linear turun  

 

 

 

 

 

Gambar 2.7 Representasi Linear Turun 

Fungsi Keanggotaan 

           

          (2.3) 

b.  Representasi Kurva Segitiga 

Representasi kurva segitiga merupakan gabungan antara dua representasi 

linear, seperti yang terlihat pada Gambar 2.8. 

1 

0 a Domain b 

Derajat 
Keanggotaan 

𝜇 [𝑋] 

𝑋 

1 

0 
a Domain

n 

b 

Derajat 
Keanggotaan 

𝜇 [𝑋] 

𝑋 

0 ;  𝑥 ≤ 𝑎 

 
(𝑥−𝑎)

(𝑏−𝑎)
 ; 𝑎 < 𝑥 < 𝑏 

1 ; 𝑥 ≤ 𝑏 

𝜇[𝑋]= 

 
(𝑏−𝑥)

(𝑏−𝑎)
 ; 𝑎 ≤ 𝑥 < 𝑏 

0 ; 𝑥 ≥ 𝑏 

𝜇[𝑋]= 
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Gambar 2.8 Representasi Kurva Segitiga 

Fungsi Keanggotaan: 

(2.4) 

 

d.  Representasi Kurva Bahu 

Himpunan fuzzy bahu digunakan untuk mengakhiri variabel suatu daerah 

fuzzy.  Bentuk kurva bahu berbeda dengan kurva segitiga, yaitu salah satu sisi pada 

variabel tersebut mengalami perubahan turun atau naik, sedangkan sisi yang lain 

tidak mengalami perubahan atau tetap.  Bahu kiri bergerak dari benar ke salah, 

demikian juga bahu kanan bergerak dari salah ke benar. Gambar 2.9 menunjukkan 

variabel TEMPERATUR dengan daerah bahunya.  

 

 

 

 

 

 

Gambar 2.9 Kurva Bahu Variabel Temperatur 

 

0 ;  𝑥 ≤ 𝑎 atau 𝑥 ≥ 𝑐 

 
(𝑥−𝑎)

(𝑏−𝑎)
 ; 𝑎 < 𝑥 < 𝑏 

(𝑐−𝑥)

(𝑐−𝑏)
 ; 𝑏 ≤ 𝑥 < 𝑐 

𝜇[𝑋]= 
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2.4.3 Metode Fuzzy Mamdani 

Fuzzy Inference System (FIS), yaitu suatu kerangka komputasi yang 

didasarkan pada teori himpunan fuzzy, aturan fuzzy berbentuk IF-THEN, dan 

penalaran fuzzy (Kusumadewi & Hartati, 2010: 40). Dalam penelitian ini sistem 

inferensi fuzzy yang digunakan adalah metode mamdani, yaitu untuk menetukan 

durasi lampu hijau dengan memperhatikan jumlah mobil dan jumlah motor yang 

berhenti saat lampu merah. 

Metode Mamdani dikenal juga sebagai metode Min-Max, metode ini 

diperkenalkan oleh Ebrahim Mamdani pada tahun 1975. Pada metode ini, tahapan 

yang diperlukan untuk memperoleh output adalah ditunjukkan pada Gambar 2.10. 

 

Gambar 2.10 Flowchart Metode Fuzzy Mamdani 

1. Pembentukan himpunan fuzzy 

Pembentukan himpunan fuzzy sering dikenal dengan istilah fuzzifikasi. 

Fuzzifikasi adalah suatu proses pengubahan nilai input (tegas) ke dalam input fuzzy 

menggunakan fungsi keanggotaan (Setiadji, 2009).  

Himpunan fuzzy didasarkan pada tingkatan lingustiknya yang 

dikelompokkan dalam suatu variabel fuzzy. Setiap himpunan fuzzy ditentukan 

domain dan fungsi keanggotaan yang digunakan untuk menentukan nilai 

keanggotaan real, dimana nilai keanggotaan tersebut terletak pada interval [0,1].  

2. Aplikasi fungsi implikasi 

Aplikasi fungsi implikasi terdiri dari aturan-aturan yang dibentuk untuk 

menyelesikan relasi antara input dan output, setiap aturan merupakan suatu 

Pembentukan 
Himpunan Fuzzy 

Aplikasi Fungsi 
Implikasi 

Komposisi 
Aturan  

Penegasan 
(Defuzzifikasi) 
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implikasi. Operator yang digunakan untuk menghubungkan antara dua input adalah 

operator AND. Pemetakkan antar input-output adalah IF-THEN. Proposisi yang 

mengikuti IF disebut anteseden, sedangkan proposisi yang mengikuti THEN 

disebut konsekuen. Fungsi implikasi yang digunakan adalah Min, yaitu dengan cara 

mencari nilai minimum berdasarkan aturan ke-𝑖 dapat dinyatakan dengan: 

𝛼𝑖 = 𝜇𝐴𝑖(𝑥) ∩ 𝜇𝐵𝑖(𝑥) = 𝑚𝑖𝑛{𝜇𝐴𝑖(𝑥), 𝜇𝐵𝑖(𝑥)}   (2.5) 

Keterangan:  

𝛼𝑖 = nilai minimum dari himpunan fuzzy A dan B pada aturan ke-𝑖 

𝜇𝐴𝑖(𝑥) = derajat keanggotaan 𝑥 dari himpunan fuzzy A pada aturan ke-𝑖  

𝜇𝐵𝑖(𝑥) = derajat keanggotaan 𝑥 dari himpunan fuzzy B pada aturan ke-𝑖  

3. Komposisi aturan (Agregasi) 

Pada metode Mamdani, komposisi antar aturan, menggunakan fungsi MAX 

yaitu megambil nilai maksimum dari output aturan kemudian menggabungkan 

daerah fuzzy dari masing-masing aturan dengan operator OR. 

µ 𝑠𝑓[𝑥] =  𝑚𝑎𝑥 (µ 𝑘𝑓[𝑥𝑖])      (2.6) 

Keterangan :  

µ 𝑠𝑓[𝑥]  = nilai keanggotaan solusi fuzzy sampai aturan ke-i  

µ 𝑘𝑓[𝑥𝑖] = nilai keanggotaan konsekuen fuzzy aturan ke-𝑖, dimana 𝑖 = 1,2,3, … … , 𝑛 

4. Penegasan (Defuzzifikasi) 

Input dari proses defuzzifikasi adalah suatu himpunan fuzzy yang diperoleh 

dari suatu komposisi aturan-aturan fuzzy dan output yang dihasilkan adalah suatu 

bilangan pada himpunan fuzzy tersebut. Sehingga jika diberikan suatu himpunan 

fuzzy dalam range tertentu, maka dapat diambil suatu nilai crisp tetentu sebagai 
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outputnya. Salah satu metode defuzzifikasi yang digunakan pada komposisi aturan 

Mamdani adalah Metode Centroid. Metode Centroid dalam mencari solusi crisp 

dengan cara mengambil titik pusat daerah fuzzy. Secara umum dirumuskan sebagai 

berikut : 

𝑍0 =
∫ 𝑧.𝜇(𝑍) 𝑑𝑧

𝑏
𝑎

∫  𝜇(𝑍) 𝑑𝑧
𝑏

𝑎

 , untuk domain kontinu     (2.7) 

Keterangan : 

Z  = niali domain ke-i 

 𝜇(𝑍)  = derajat keanggotaan titik tersebut 

𝑍0 = nilai hasil defuzzifikasi 

𝑍 =
∑ 𝑑𝑖.𝑈𝐴𝑖

𝑛
𝑖=1

∑ 𝑈𝐴𝑖
(𝑑𝑖)𝑛

𝑖=𝑗

, untuk domain diskret     (2.8) 

Keterangan : 

Z  = nilai hasil defuzzifikasi 

 𝑑𝑖 = nilai keluaran pada aturan ke-i 

𝑈𝐴𝑖
(𝑑𝑖)= derajat keanggotaan nilai keluaran pada aturan ke-i 

𝑛 = banyaknya aturan yang digunakan 

Contoh 2.3 (Abrori & Prihamayu, 2015) 

Abrori dan Prihamayu menggunakan metode Fuzzy Mamdani untuk menentukan 

jumlah juice apple yang dipesan PT. Sukanda Djaya. PT. Sukanda Djaya adalah 

sebuah perusahaan yang bergerak di bidang distribusi ice cream dan frozen food. 

Berdasarkan data permintaan dan persediaan pada periode September 2009- 

Agustus 2010, menunjukkan permintaan produk terbesar mencapai 934 kemasan 

per bulan, dan permintaan terkecil mencapai 104 kemasan per bulan. Sedangkan 
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persediaan produk terbanyak mencapai 198 kemasan per bulan dan persediaan 

terkecil mencapai 42 kemasan per bulan. 

Penentuan jumlah pemesanan juice apple menggunakan metode Fuzzy Mamdani 

sebagai berikut: 

a. Pembentukan Himpunan Fuzzy 

 Ada 2 variabel input terkait penentuan jumlah pemesanan yaitu variabel 

permintaan dan variabel persediaan. Sedangkan variabel outputnya adalah variabel 

pemesanan. 

1. Variabel permintaan terdiri atas 2 himpunan fuzzy yaitu Turun dan Naik. 

Kurva fungsi keanggotaan untuk variabel permintaan, seperti pada Gambar 

2.11. 

 

 

 

 

Gambar 2.11 Kurva Fungsi Keanggotaan untuk Variabel Permintaan 

 

Fungsi keanggotaan: 

𝜇𝑇𝑢𝑟𝑢𝑛 = {

1
934−𝑥

830

0

 

     ; 𝑥 ≤ 104              
      ;  104 < 𝑥 < 934

; 𝑥 ≥ 934        
     (2.9) 

𝜇𝑁𝑎𝑖𝑘 = {

0
𝑥−104

830

1

 

    ; 𝑥 ≤ 104             
      ;  104 < 𝑥 < 934

; 𝑥 ≥ 934        
     (2.10) 

104 

1 

934 

Turun Naik 

Permintaan (kemasan) 

𝜇
𝑃

𝑒
𝑟

𝑚
𝑖𝑛

𝑡𝑎
𝑎

𝑛
 

0 



32 
 

 
 

2. Variabel persediaan terdiri atas 2 himpunan fuzzy yaitu Sedikit dan Banyak. 

Kurva fungsi keanggotaan untuk variabel persediaan, seperti pada Gambar 

2.12. 

 

 

 

 

 

 

Gambar 2.12 Kurva Fungsi Keanggotaan untuk Variabel Persediaan 

Fungsi keanggotaan: 

𝜇𝑆𝑒𝑑𝑖𝑘𝑖𝑡 = {

1
198−𝑥

156

0

 

     ; 𝑥 ≤ 42              
     ;  42 < 𝑥 < 198

; 𝑥 ≥ 198       
     (2.11) 

𝜇𝐵𝑎𝑛𝑦𝑎𝑘 = {

0
𝑥−42

156

1

    ; 𝑥 ≤ 42              
    ;  42 < 𝑥 < 198

; 𝑥 ≥ 198        
     (2.12) 

3. Variabel pemesanan terdiri atas 2 himpunan fuzzy yaitu Berkurang dan 

Bertambah. Kurva fungsi keanggotaan untuk variabel pemesanan, seperti pada 

Gambar 2.13. 

 

 

 

 

Gambar 2.13 Kurva Fungsi Keanggotaan untuk Variabel Pemesanan 

Fungsi keanggotaan: 

𝜇𝐵𝑒𝑟𝑘𝑢𝑟𝑎𝑛𝑔 = {

1
1020−𝑥

690

0

 

    ; 𝑥 ≤ 330              
      ;  330 < 𝑥 < 1020

; 𝑥 ≥ 1020        
    (2.13) 
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𝜇
𝑃

𝑒
𝑚
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𝑠𝑎
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𝑎

𝑛
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42 
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Persediaan (kemasan)  

𝜇
𝑃

𝑒
𝑟

𝑠𝑒
𝑑

𝑖𝑎
𝑎
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𝜇𝐵𝑒𝑟𝑡𝑎𝑚𝑏𝑎ℎ = {

0
𝑥−330

690

1

 

   ; 𝑥 ≤ 330              
      ;  330 < 𝑥 < 1020

; 𝑥 ≥ 1020        
    (2.14) 

Jika data bulan agustus 2010 adalah permintaan 540 kemasan dan persediaan 

132 kemasan maka fungsi keanggotaanya sebagai berikut: 

1) Fungsi keanggotaan untuk permintaan 540 kemasan, menggunakan 

persamaan (2.9) dan (2.10). 

𝜇𝑇𝑢𝑟𝑢𝑛 =
934 − 540

830
= 0.47 

𝜇𝑁𝑎𝑖𝑘 =
540 − 104

830
= 0.53 

2) Fungsi keanggotaan untuk persediaan 132 kemasan, menggunakan 

persamaan (2.11) dan (2.12). 

𝜇𝑆𝑒𝑑𝑖𝑘𝑖𝑡 =
198 − 132

156
= 0.42 

𝜇𝐵𝑎𝑛𝑦𝑎𝑘 =
132 − 42

156
= 0.58 

b. Aplikasi Fungsi Implikasi 

 Aplikasi yang digunakan adalah aturan MIN, sebagai berikut: 

[R1] IF permintaan Turun dan persediaan Banyak THEN pemesanan Berkurang  

𝛼 − 𝑝𝑟𝑒𝑑𝑖𝑘𝑎𝑡1 = 𝜇𝑃𝑒𝑟𝑚𝑖𝑛𝑡𝑎𝑎𝑛 𝑇𝑢𝑟𝑢𝑛 ∩ 𝜇𝑃𝑒𝑟𝑠𝑒𝑑𝑖𝑎𝑎𝑛 𝐵𝑎𝑛𝑦𝑎𝑘 

               = min(𝜇𝑃𝑒𝑟𝑚𝑖𝑛𝑡𝑎𝑎𝑛 𝑇𝑢𝑟𝑢𝑛(0.47)) , (𝜇𝑃𝑒𝑟𝑠𝑒𝑑𝑖𝑎𝑎𝑛 𝐵𝑎𝑛𝑦𝑎𝑘(0.58)) 

                   = min(0.47, 0.58) = 0.47 

[R2] IF permintaan Turun dan persediaan Sedikit THEN pemesanan Berkurang  

𝛼 − 𝑝𝑟𝑒𝑑𝑖𝑘𝑎𝑡2 = 𝜇𝑃𝑒𝑟𝑚𝑖𝑛𝑡𝑎𝑎𝑛 𝑇𝑢𝑟𝑢𝑛 ∩ 𝜇𝑃𝑒𝑟𝑠𝑒𝑑𝑖𝑎𝑎𝑛 𝑆𝑒𝑑𝑖𝑘𝑖𝑡 

               = min(𝜇𝑃𝑒𝑟𝑚𝑖𝑛𝑡𝑎𝑎𝑛 𝑇𝑢𝑟𝑢𝑛(0.47)) , (𝜇𝑃𝑒𝑟𝑠𝑒𝑑𝑖𝑎𝑎𝑛 𝑆𝑒𝑑𝑖𝑘𝑖𝑡(0.42)) 
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                   = min(0.47, 0.42) = 0.42 

[R3] IF permintaan Naik dan persediaan Banyak THEN pemesanan Bertambah 

𝛼 − 𝑝𝑟𝑒𝑑𝑖𝑘𝑎𝑡3 = 𝜇𝑃𝑒𝑟𝑚𝑖𝑛𝑡𝑎𝑎𝑛 𝑁𝑎𝑖𝑘 ∩ 𝜇𝑃𝑒𝑟𝑠𝑒𝑑𝑖𝑎𝑎𝑛 𝐵𝑎𝑛𝑦𝑎𝑘 

               = min(𝜇𝑃𝑒𝑟𝑚𝑖𝑛𝑡𝑎𝑎𝑛 𝑁𝑎𝑖𝑘(0.53)) , (𝜇𝑃𝑒𝑟𝑠𝑒𝑑𝑖𝑎𝑎𝑛 𝐵𝑎𝑛𝑦𝑎𝑘(0.58)) 

                   = min(0.53, 0.58) = 0.53 

[R4] IF permintaan Naik dan persediaan Sedikit THEN pemesanan Bertambah 

𝛼 − 𝑝𝑟𝑒𝑑𝑖𝑘𝑎𝑡4 = 𝜇𝑃𝑒𝑟𝑚𝑖𝑛𝑡𝑎𝑎𝑛 𝑁𝑎𝑖𝑘 ∩ 𝜇𝑃𝑒𝑟𝑠𝑒𝑑𝑖𝑎𝑎𝑛 𝑆𝑒𝑑𝑖𝑘𝑖𝑡 

               = min(𝜇𝑃𝑒𝑟𝑚𝑖𝑛𝑡𝑎𝑎𝑛 𝑁𝑎𝑖𝑘(0.53)) , (𝜇𝑃𝑒𝑟𝑠𝑒𝑑𝑖𝑎𝑎𝑛 𝑆𝑒𝑑𝑖𝑘𝑖𝑡(0.42)) 

                   = min(0.53, 0.42) = 0.42 

c.  Komposisi Aturan (Agregasi) 

 Metode yang digunakan dalam komposisi antar semua aturan adalah 

metode MAX. 

𝜇𝑠𝑓(𝑥) = 𝑚𝑎𝑘𝑠{𝜇 𝑃𝑒𝑚𝑒𝑠𝑎𝑛𝑎𝑛 𝐵𝑒𝑟𝑘𝑢𝑟𝑎𝑛𝑔(𝑥) ∪ 𝜇𝑃𝑒𝑚𝑒𝑠𝑎𝑛𝑎𝑛 𝐵𝑒𝑟𝑡𝑎𝑚𝑏𝑎ℎ(𝑥)} 

    = 𝑚𝑎𝑘𝑠{0.47; 0.42; 0.53; 0.42} 

    = {0.47; 0.53} 

Berikut daerah hasil komposisi disajikan pada Gambar 2.14,  

 

 

 

 

 

 

Gambar 2.14 Daerah Hasil Komposisi 
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Mencari titik a, dan b. 

Titik a adalah ketika 𝜇𝑃𝑒𝑚𝑒𝑠𝑎𝑛𝑎𝑛 𝐵𝑒𝑟𝑡𝑎𝑚𝑏𝑎ℎ(𝑥) = 0.47, sehingga 

Titik a 

𝑥 − 330

690
= 0.47 

𝑥 − 330 = 324.3 

𝑥 = 654.3 

Titik b adalah ketika 𝜇𝑃𝑒𝑚𝑒𝑠𝑎𝑛𝑎𝑛 𝐵𝑒𝑟𝑡𝑎𝑚𝑏𝑎ℎ(𝑥) = 0.53, sehingga 

Titik b 

𝑥 − 330

690
= 0.53 

𝑥 − 330 = 365.7 

𝑥 = 695.7 

Dengan demikian, fungsi keanggotaan untuk hasil komposisi diatas adalah 

𝜇𝑃𝑒𝑚𝑒𝑠𝑎𝑛𝑎𝑛 = {

0.47      ; 0 ≤ 𝑥 ≤ 654.3
𝑥−330

690
      ; 654.3 < 𝑥 < 695.7

    0.53          ; 695.7 ≤ 𝑥 ≤ 1020

    (2.13) 

d.  Defuzzifikasi 

Defuzzifikasi dikerjakan menggunakan metode Centroid 

𝑋 =
∫ 0.47𝑥𝑑𝑥 + ∫ (

𝑥 − 330
690 )  𝑥𝑑𝑥 + ∫ 0.53𝑥𝑑𝑥

1020

695.7

695.7

654.3

654.3

0

∫ 0.47𝑑𝑥 + ∫ (
𝑥 − 330

690 )  𝑑𝑥 + ∫ 0.53𝑑𝑥
1020

695.7

695.7

654.3

654.3

0

 

=
∫ 0.47𝑥𝑑𝑥 + ∫ (

𝑥2 − 330𝑥
690𝑥 )  𝑑𝑥 + ∫ 0.53𝑥𝑑𝑥

1020

695.7

695.7

654.3

654.3

0

∫ 0.47𝑑𝑥 + ∫ (
𝑥 − 330

690
)  𝑑𝑥 + ∫ 0.53𝑑𝑥

1020

695.7

695.7

654.3

654.3

0
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=

[0.235𝑥2]0
654.3 + [

𝑥
3

3
− 165𝑥2

345𝑥2 ]

654.3

695.7

+ [0.265𝑥2]695.7
1020

[0.47𝑥]0
654.3 + [

0.5𝑥2 − 330𝑥
690𝑥 ]

654.3

695.7

+ [0.53𝑥]695.7
1020

 

=
100605.4952 + 0.04 + 147446.4002

307.521 + 0.03 + 171.879
 

=
248051.9353

479.43
 

= 517.389265 ≈ 517 

Jadi jumlah pemesanan produk untuk bulan September 2010, dengan data bulan 

Agustus 2010 yaitu permintaan 540 kemasan dan persediaan 132 kemasan adalah 

sebanyak 517 kemasan. 

2.5 Fuzzy Logic Toolbox Matlab R2014a 

Fuzzy logic toolbox adalah sekumpulan tool yang membantu merancang 

sistem fuzzy (Naba, 2009). Fuzzy logic toolbox menyediakan 5 jenis GUI untuk 

keperluan rancang bangun FIS yaitu, FIS editor, membership function editor, rule 

editor, rule viewer, dan surface viewer. 

a.  FIS Editor 

Ketik fuzzy pada Command Window maka akan muncul FIS Editor, seperti 

pada Gambar 2.15. 
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Gambar 2.15 FIS Editor 

Pada Gambar 2.15 FIS yang digunakan adalah tipe Mamdani dengan fungsi 

Implication berupa min, Aggregation berupa max dan Deffuzifikasi menggunakan 

metode Centroid. Gambar 2.15 terdapat satu variabel input dan satu variabel output.  

 Langkah membangun FIS pada FIS Editor 

1.  Pilih Edit→ Add Variable → Input, untuk menambah variabel input 

2.  Ubah label Input1 dengan mengeklik kotak bewarna kuning berlabel Input1, 

lalu pada kotak Current Variable pada kolom Name, ganti label Input1 sesuai 

nama yang diinginkan, kemudian Enter, berlaku hal yang sama dengan Input2. 

3.  Ubah label Output1 dengan mengeklik kotak bewarna biru berlabel Output1, 

lalu pada kotak Current Variable pada kolom Name, ganti label Output1 sesuai 

nama yang diinginkan, kemudian Enter. 

4. Pilih File →Export → 𝑇𝑜 Workspace, ketik nama Workspace klik OK 

5. Pilih File →Export → 𝑇𝑜 𝐹𝑖𝑙𝑒, ketik nama File klik OK, file akan tersimpan 

secara langsung ke harddisk. 

 



38 
 

 
 

b. Membership Function Editor 

 Dari FIS Editor, pilih Edit → Membership Function, maka muncul seperti 

Gambar 2.16. 

 
Gambar 2.16 Membership Function Editor 

 Membership function editor menampilkan dan mengedit semua fungsi 

keanggotaan dari variabel FIS input dan output dengan mengklik salah satu ikon 

variabel sehingga kurva fungsi keanggotaan akan ditampilkan pada sebelah kanan. 

Klik ikon variabel FIS, pada field Range bagian kiri bawah , ubah Range sesuai 

dengan himpunan semesta variabel FIS, kemudian klik kurva yang berlabel mf1, 

pada bagian kanan bawah, ubah nama mf1 dan tipe kurva pada field Type sesuai 

yang dibutuhkan dan atur parameter setiap fungsi pada field Params, berlaku juga 

dengan mf2 dan mf3. 

c.  Rule Editor 

Dari membership function editor, Pilih Edit >Rule maka muncul Gambar 2.17. 
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Gambar 2.17 Rule Editor 

Memasukkan Rule secara otomatis yakni klik Input1, klik Input2 dan Output1 

kemudian klik Add rule. Rule berupa fungsi Impliasi IF-THEN, pilih and pada 

Connection untuk menghubungkan antar variabel Input. 

d. Rule Viewer 

Dari Rule Editor, pilih View →Rule, maka muncul seperti Gambar 2.18. 

 
Gambar 2.18 Rule Viewer 
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 Nilai input dapat diubah dengan mengetik langsung pada field Input pada pojok 

kiri bawah. 

Contoh 2.4  

Penentuan pemesanan produk pada PT. Sukanda Djaya seperti pada contoh 2.3 

dapat diselesaikan dengan bantuan Fuzzy Logic Toolbox Matlab R2014a, sebagai 

berikut : 

1.  FIS Editor 

Variabel input yaitu variabel permintaan dan variabel persediaan, dengan 

metode Fuzzy Mamdani. Fungsi Implication berupa min, Aggregation berupa max 

dan Deffuzifikasi menggunakan metode Centroid, seperti Gambar 2.19. 

 
Gambar 2.19 FIS Editor: Penentuan Pemesanan Produk 

2. Membership Function Editor 

 Variabel input permintaan terdiri 2 himpunan fuzzy, yaitu Turun dan Naik. 

Kurva bahu kiri untuk himpunan fuzzy Turun dan kurva linear naik untuk himpunan 

fuzzy Naik. Berikut Gambar Membership Function Editor untuk variabel 

permintaan disajikan pada Gambar 2.20. 
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Gambar 2.20 Membership Function Editor untuk Variabel Permintaan 

Variabel input persediaan terdiri 2 himpunan fuzzy, yaitu Sedikit dan Banyak. 

Kurva bahu kiri untuk himpunan fuzzy Sedikit dan kurva linear naik untuk 

himpunan fuzzy Banyak. Berikut Gambar Membership Function Editor untuk 

variabel persediaan disajikan pada Gambar 2.21. 

 
Gambar 2.21 Membership Function Editor untuk Variabel Persediaan 

Variabel output pemesanan terdiri 2 himpunan fuzzy, yaitu Berkurang dan 

Bertambah. Kurva bahu kiri untuk himpunan fuzzy Berkurang dan kurva linear naik 
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untuk himpunan fuzzy Bertambah. Berikut Gambar Membership Function Editor 

untuk variabel output pemesanan disajikan pada Gambar 2.22. 

 
Gambar 2.22 Membership Function Editor untuk Variabel Pemesanan 

3. Rule Editor 

Rule yang sudah terbentuk pada contoh 2.3 dimasukkan kedalam rule editor, 

seperti pada Gambar 2.23. 

 
Gambar 2.23 Rule Editor: Penentuan Pemesanan Produk 
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4. Rule Viewer 

Hasil perhitungan penentuan pemesanan produk dengan bantuan fuzzy logic 

toolbox Matlab R2014a yaitu 522 kemasan, jika permintaan mencapai 540 kemasan 

dan persediaan mencapai 132 kemasan, seperti yang diperlihatkan pada Gambar 

2.24. 

 
Gambar 2.24 Rule Viewer: Penentuan Pemesan Produk 

Hasil yang diperoleh dari contoh 2.3 secara perhitungan manual dan contoh 

2.4 dengan bantuan fuzzy logic toolbox Matlab R2014a berbeda yaitu pada contoh 

2.3 manual sebesar 517 kemasan dan pada contoh 2.4 dengan bantuan fuzzy logic 

toolbox Matlab R2014a sebesar 522 kemasan. Perbedaan hasil manual dan fuzzy 

logic toolbox Matlab R2014a dikarenakan adanya pembulatan angka di dalam 

perhitungan. 

2.6 Pengaturan Lampu Lalu Lintas  

Menurut MKJI (1997), tipe jalan di perkotaan terdiri atas: 

1. Jalan dua lajur- dua arah (2/2 UD) 

2. Jalan empat lajur- dua arah tak terbagi (4/2 UD) 
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3. Jalan empat lajur- dua arah terbagi (4/2 D) 

4. Jalan enam-lajur- dua arah- terbagi (6/2 D) 

5. Jalan satu arah (1-3/1) 

Persimpangan menurut MKJI (1997) adalah dua buah ruas jalan atau lebih 

yang saling bertemu, saling berpotongan, atau saling bersilangan. Persimpangan 

terbagi menjadi 2 yaitu: 

1. Simpangan bersinyal 

Simpangan bersinyal adalah persimpangan yang arus lalu lintasnya diatur 

menggunakan lampu lalu lintas. 

2. Simpangan tak bersinyal 

Simpangan tak bersinyal adalah persimpangan yang arus lalu lintasnya tidak 

diatur menggunakan lampu lalu lintas. 

Lampu lalu lintas (traffic light) adalah perangkat sinyal yang terletak di titik 

persimpangan jalan yang digunakan untuk mengendalikan penyelesaian arus lalu 

lintas (Kham & New, 2014: 1). Lampu lalu lintas terbagi menjadi 3 yaitu lampu 

merah, kuning dan hijau. Tujuan lampu lalu lintas, sebagai berikut: 

1. Menghindari hambatan karena adanya perbedaan arus jalan bagi pergerakan 

kendaraan. 

2. Memfasilitasi persimpangan  antara  jalan utama  untuk kendaraan dan pejalan 

kaki  dengan  jalan  sekunder  sehingga  kelancaran  arus  lalu lintas dapat 

terjamin. 

3. Mengurangi tingkat kecelakaan yang diakibatkan oleh tabrakan karena 

perbedaan arus jalan. 
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Fase adalah rangkaian isyarat yang dipergunakan untuk mengurus arus 

kendaraan untuk diperbolehkan bergerak atau berhenti (Bien et al., 2019:115). 

Waktu antar hijau adalah periode waktu lampu merah menyala semua antara 

dua fase yang berurutan. Hal ini supaya akhir rombongan kendaraan pada fase 

sebelumnya tidak berbenturan dengan awal rombongan kendaraan pada fase 

berikutnya. Nilai normal waktu antar hijau disajikan pada Tabel 2.2. 

Tabel 2.2 Nilai Normal Waktu Antar Hijau 

Ukuran 

Simpang 

Lebar Jalan 

Rata-Rata 

(m) 

Nilai Normal 

Waktu antar Hijau 

Kecil 6 − 9 4 detik per fase 

Sedang 10 − 14 5 detik per fase 

Besar ≥ 15 ≥ 6 detik per fase 
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BAB 5 

PENUTUP 

5.1  Simpulan 

1. Hasil pengaturan fase lampu lalu lintas dengan algoritma Bee Colony 

Dari hasil pengamatan pengaturan fase lampu lalu lintas saat ini di 

persimpangan simpang empat Jl. Tambak Dalam Raya- Jl. Soekarno Hatta- Jl. 

Gajah Raya memiliki 3 fase, dengan terdapat adanya tabrakan antar arus kendaraan 

di fase 1, sedangkan pada pengaturan fase lampu lalu baru menggunakan algoritma 

Bee Colony diperoleh 4 fase, dengan setiap ruas jalan diatur oleh satu fase, dan pada 

fase lampu lalu lintas baru menggunakan algoritma Bee Colony ini tidak ditemui 

adanya tabrakan antar arus kendaraan, sehingga dapat mengurangi resiko 

kecelakaan. 

2. Hasil perhitungan durasi lampu lalu lintas pada fase lampu lalu lintas baru 

dengan metode Fuzzy Mamdani 

Durasi lampu lalu lintas saat ini di  memiliki durasi yang konstan atau tetap 

yang artinya untuk pengaturan durasi lampu hijau belum memperhatikan jumlah 

mobil dan motor yang berhenti saat lampu merah, sedangkan pada durasi lampu 

lalu lintas yang telah diatur menggunakan metode Fuzzy Mamdani memiliki durasi 

lampu lalu lintas yang berubah mengikuti jumlah mobil dan jumlah motor yang 

berhenti saat lampu merah. 
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5.2  Saran 

Berdasarkan hasil penelitian maka saran yang dapat disampaikan sebagai 

berikut. 

1.  Penelitian skripsi ini untuk pengaturan fase lampu lalu lintas masih secara 

manual untuk penelitian selanjutnya dapat dikembangkan dengan program. 

2. Penelitian selanjutnya dapat dikembangkan fase lampu lalu lintas dengan arus 

belok kiri dapat berjalan lebih dari satu fase tanpa mengganggu arus kendaraan 

dari arah lain. 

3. Penelitian selanjutnya dapat dikembangkan dengan uji numerik dan 

dikembangkan dengan program visualisasi sistem lampu lalu lintas untuk 

membuktikan keefektifan dari sistem lampu lalu lintas yang diperoleh. 

4. Penelitian ini dapat menjadi bahan masukan bagi Dinas Perhubungan, 

Komunikasi, dan Informatika (DISHUBKOMINFO) Kota Semarang untuk 

mengatur fase lampu lalu lintas dan durasi lampu lalu lintas yang 

memperhatikan jumlah mobil dan motor yang berhenti saat lampu merah.  
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